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Data Explorer 

Data Explorer is a web tool that provides a quick and easy way of visualizing and analyzing data. You can use 
Data Explorer in any major browser and on Mac, PC, Chromebook, and tablets. It is not optimized for mobile 
devices. 

This guide describes the parts and functions of the Data Explorer interface. You can click on each of the following 
sections to jump directly to that part of the guide. 
• Launch the Tool (Landing Page)
• Save or Download a Project
• Reset or Continue a Project
• Background and Related Activities for Data Sets
• Examine a Data Table
• Cross Tabulation
• Visualize Data with Plots

o Variables and Filters for Plots
o Plot Display Features
o Examine Data Points in a Scatterplot

• Analyze Data with Statistical Analyses
o Variables and Filters for Analyses
o Analysis Results

• Help and Frequently Asked Questions (FAQs)
• Caveats and Technical Details

More information about Data Explorer can also be found in these places: 
● Some options inside Data Explorer have question mark icons ( ), which you can hover over for more

information.
● Implementation suggestions and more guides can be found on this resource’s webpage.
● Additional resources and help can be found in the footer menu for Data Explorer.

https://www.biointeractive.org/classroom-resources/data-explorer
https://www.biointeractive.org/classroom-resources/data-explorer
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Launch the Tool (Landing Page)  

Go to the Data Explorer webpage and click the “Launch Tool” button. This will open the landing page for Data 
Explorer.  

If you’re new to Data Explorer, you may want to watch the video under the “First time here?” section. The video 
gives a brief overview of the tool and its features. 

To start working on a data set, you can choose from three options: 

1. Choose data to explore. This opens a curated collection of data sets with background information and 
related activities. This collection will be updated to add more data sets over time. 

2. Import your own data set. This lets you upload a data set. You can see the guidelines for data sets after you 
click this option.  
a. If you are having trouble importing or using a data set, reviewing the guidelines may be helpful. In 

particular, the file size must be smaller than 5 MB in the “Upload File” window. 
3. Open saved project. This lets you open a project that you previously downloaded from Data Explorer (as a 

JSON file). See the “Save or Download a Project” section for more information. 
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Save or Download a Project 

As you work on a Data Explorer project, your device will automatically save your progress in your browser 
cookies. If you reopen Data Explorer on the same device and browser later (and didn’t clear your cookies), your 
data set and results should still be there.  

If you’d like to open your project on a different device, or want to save your project before starting a new one, 
you should download it as a separate file. 

1. Click “Save project” in the top-right corner, and your project will be downloaded as a JSON file.  
2. To continue working on the project, open the JSON file using the “Open saved project” option. This option is 

available through the hamburger menu in the top-right corner and on the Data Explorer landing page. 

 
 
 
Reset or Continue a Project 

In addition to “Save Project,” you will see two other buttons in the top-right corner: 

1. The “Reset app” button appears on every page of Data Explorer. Use this button to delete all your progress 
(browser cookies) and start over with a new project. 

2. The “Continue project” button appears only on the landing page. You’ll see it if you close Data Explorer, 
then return on the same device and browser later. Use this button to return to your current project. 
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Background and Related Activities for Data Sets 

The data sets in the “Choose data to explore” section of the landing page are all from real scientific studies. If 
you open one of these data sets, there will be an extra “Background” option in the top-left corner. Click the 
“Background” option to see more information about the study, what the data set includes, and related 
resources. 

In particular, the section called “Related Activity” has a link to an activity that can be used with the data set. 
Click the link to go to the activity’s page, which has more resources for both students and educators.   
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Examine a Data Table 

You can examine the data set by selecting the “Data Table” option in the “Data” tab. 

1. Use the “Download data set” button to download the data set as a CSV file. You can edit the downloaded 
data set or use it in another program.  

2. The icon for each variable (column) indicates its type. There are two variable types, which affect the plots 
and statistical analyses in which a variable can be used: 

Numerical: Variables with quantitative observations, which are always numbers. 

Categorical: Variables with qualitative observations, which are often names or labels for different 
groups. 

(Variable types are automatically assigned by Data Explorer; see Caveat 1 for details.) 
3. Clicking a column name will sort the rows based on that column. The arrow indicates whether the entries 

are in ascending or descending order.  
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Cross Tabulation 

Cross tabulation, also known as contingency tables or pivot tables, is a way of grouping variables to look at their 
relationships. It creates a table that summarizes data across variables. 

You can access this feature by selecting the “Cross Tabulation” option in the “Data” tab. 

1. Choose one or more numerical variables to show in the columns. 
2. Choose one or more categorical variables to show in the rows.  
3. Your results will appear in the “Cross tabulation results” window on the right. If you selected multiple row 

variables, only the first one will be shown by default. 

 

4. Click the cells with a “>” symbol to show more row variables. 
5. Click and drag the row variables at the top to change their order. 
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6. Click the gear button (        ) next to a row variable to open the menu shown below. In this menu, you can 
sort, select, or filter out specific groups for that variable.  

 

  



Data Explorer 

www.BioInteractive.org Published May 2021 
 Page 8 of 16 
 

Tools 
How to Use Guide 

Visualize Data with Plots 

Use the “Visualize” tab to create plots (graphs) of the data.  

1. To create a new plot, click the “Add a new plot” button in the “Plot list” window. Multiple plots can be 
added to this list. 
a. For more help selecting a plot, check out the “Plot Selection Guide” on the Data Explorer webpage. 

2. Select the plot settings in the “Edit plot” window, which includes the following options: 
a. Variables and Filters: Sets the variables for the plot. See the “Variables and Filters for Plots” section 

below for more information. 
b. Styles: Sets the styles for the plot’s components (text color, line color, line style, etc.).  
c. Title: Sets the title for the plot. If you don’t set a title, it will be automatically generated. 

3. Your plot will appear in the “Plot display” window. See the “Plot Display Features” section below for more 
information. 

4. You can view the data set in the “Data sheet” window. After the variables are selected for a plot, the rows 
that do not have data for the selected variable(s) will be removed in the “Data sheet.” 

5. You can collapse or expand any window by clicking its title (gray bar). 

 

  

https://www.biointeractive.org/classroom-resources/data-explorer
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Variables and Filters for Plots 
Set up or edit your plot using “Variables and Filters” in the “Edit Plot” window. The exact options will depend 
on the plot type. In general: 

1. Select your variables using the dropdown menus under “X-axis variable” and “Y-axis variable.”
a. Certain variable types (numerical or categorical) may be required. Variable types that are not

appropriate for your plot will be grayed out. (Variable types are automatically assigned by Data Explorer;
see Caveat 1 for details.)

2. Filtering options will appear for each selected variable.
a. For numerical variables, you can filter for a specific range of data.
b. For continuous variables, you can filter for specific groups.

3. Some plot types have a “Grouping variable” option, which you can use to sort the data into groups.
a. In the example below, the grouping variable “Sex” is used to sort the data into two groups: f (female)

and m (male).
4. The “Additional filters” option can be used to filter the data using other variables in the data set. You can

pick specific ranges or groups for each variable that you add as a “filter.”
a. In the example below, the variable “Estimated age” is used to filter out elephants that are younger than

20 years old.
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Plot Display Features 
There are several ways to examine and interact with your plot in the “Plot display” window. 

1. Hover over certain elements on the plot to reveal specific quantitative information. For example:
a. Hovering over each point in a scatterplot will show the exact values at that point.
b. Hovering over each box in a box plot will show information about the median, quartiles, etc.
c. Hovering over each bar in a bar graph will show the bar’s value.
d. Hovering over error bars will show the error bar range.

2. Download an image of the plot by clicking the icon in the top-right corner.

When you hover over a plot, the cursor will turn into a magnifying glass icon ( ). You can zoom in on part of the 
plot by clicking and dragging a square over that part.  

3. Click the “Reset zoom” button on the plot to zoom back out.
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4. Examine the filters applied to the data set to create this plot by clicking the “Filters applied” section at the 
bottom of the plot.  
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Examine Data Points in a Scatterplot 
For a scatterplot, boxes will appear in the first column of the “Data sheet” window. You can interact with these 
boxes and the data points on the scatterplot. 

1. Select specific boxes to highlight the corresponding points on the scatterplot.
2. Click specific points on the scatterplot to select the corresponding boxes.
3. Select or deselect all the boxes by clicking the first box.
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Analyze Data with Statistical Analyses 

Use the “Analyze” tab to run statistical analyses on the data.  

1. To create a new analysis, click the “Add a new analysis” button in the “Analyses list” window.  
Multiple analyses can be added to this list. 
a. For help selecting an analysis, check out the “Statistical Analysis Selection Guide” on the Data Explorer 

webpage. 
2. Select the analysis settings in the “Edit analysis” window, which includes the following options:  

a. Variables and Filters: Sets the variables for the analysis. See the “Variables and Filters for Analyses” 
section below for more information. 

b. Title: Sets the title for the analysis. If you don’t set a title, it will be automatically generated. 
3. Your results will appear in the “Statistical analysis results” window. See the “Analysis Results” section below 

for more information. 
4. You can view the data set in the “Data sheet” window. After the variables are selected for an analysis, the 

rows that do not have data for the selected variable(s) will be removed in the “Data sheet.” 
5. You can collapse or expand any window by clicking its title (gray bar). 
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Variables and Filters for Analyses 
Set up or edit your analysis using the “Variables and Filters” in the “Edit analysis” window. The exact options 
will depend on the analysis type. In general: 

1. Select your variables in the “Edit analysis” window.  
a. Each analysis may require different variables. For example, in the t test, you are asked to choose a 

“Dependent variable” and a “Grouping variable.” 
b. Certain variable types (numerical or categorical) may be required. Variable types that are not 

appropriate for your analysis will be grayed out. (Variable types are automatically assigned by Data 
Explorer; see Caveat 1 for details.) 

2. Filtering options will appear for each selected variable. 
a. For numerical variables, you can filter for a specific range of data. 
b. For continuous variables, you can filter for specific groups. 

3. The “Additional filters” option can be used to filter the data using other variables in the data set. You can 
pick specific ranges or groups for each variable that you add as a “filter.” 
a. In the example below, the variable “Years of sample collection” is used to filter out the samples that 

were collected during 1966–68. 
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Analysis Results 
The results of each analysis will be shown in the “Statistical analysis results” window, which has the following 
parts: 

1. The “Assumptions” section lists conditions that your data should satisfy in order to give reliable results for 
the analysis.  
a. You should check whether your data meets these assumptions on your own. Data Explorer does not 

check them for you. 
b. These assumptions are based on recommendations from The Analysis of Biological Data (Whitlock and 

Schluter 2009) and other sources. You may have slightly different or other assumptions that you also 
want to check. 

2. The table(s) below the assumptions show the statistical results.  
a. To interpret these results, it is helpful to have some prior knowledge in statistics. Data Explorer cannot 

make conclusions for you, as the conclusions will depend on your original question, context, how the 
data was generated, and other information specific to your analysis.  

b. For some analyses, for example, you will need to choose your own significance level (⍺), before doing 
the analysis, to decide whether your results are significant. 

3. Download an image of the analysis by clicking the icon in the top-right corner. 
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Help and Frequently Asked Questions (FAQs) 

The “Help” tab in the footer menu of Data Explorer has more information about the tool, including answers to 
frequently asked questions (FAQs). It includes the following sections: 

• Types of Variables in Data Explorer
• Choosing a Plot
• Choosing a Statistical Test
• Frequently Asked Questions (FAQs)
• Other Resources
• Feedback

If you don’t see the footer, you may need to click a “Show footer” button in the bottom-right corner of Data 
Explorer. 

Caveats and Technical Details 

1. Auto-assignment of the variable types. Data Explorer automatically assigns each variable (column) in a data 
set as numerical or categorical.
a. Columns with only numbers, with or without decimals, are considered numerical.
b. Columns that contain text or separators, such as commas or spaces between characters, are considered 

categorical. For instance, “1,000” with a comma is considered categorical.

2. Error bars in bar graphs. The error bars in Data Explorer represent 95% confidence intervals (CI). Error bars 
can also be used to represent the standard error of the mean (SEM) or standard deviation (SD); Data Explorer 
does not currently support these options.

3. Whiskers in box plots. The whiskers in Data Explorer represent the minimum and maximum of all the 
selected data. Whiskers can also be used to represent 1.5 times the interquartile range (IQR), which 
excludes outliers. Data Explorer does not currently support this option.

4. Linear regression lines with multiple groups. Data Explorer currently shows only one linear regression line 
regardless of the grouping variable. The grouping variable is not currently used to create multiple regression 
lines. However, you can apply a regression line to one group of a categorical variable by using the “Grouping 
variable” filter option.

5. Hypothesis tests. All the hypothesis tests in Data Explorer are two-tailed tests.

6. Degrees of freedom in the chi-square test of goodness of fit. Data Explorer automatically calculates degrees 
of freedom (df) for the chi-square test and does not use the correct df for Hardy-Weinberg (or any other 
intrinsic hypotheses in which df is reduced because the data are used to estimate parameters). Check the 
results for df in the “Statistical analysis results” window to determine whether they are appropriate for your 
situation.
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